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Chapter 2

Get to Know Photoshop Elements 11
What’s what and what it does
Welcome to Photoshop Elements – a
terrific, affordable photo retouching
application and graphics editor that just
seems to get better and more featurepacked with every generation!
This is a program that seems to offer more
wonderful surprises the deeper you dig
into it. It provides not only the obvious
tools for cleaning, stylizing and creating
images, but also lots of not-so-obvious
tools for managing your image files,
outputting a variety of print projects and
even sharing your work online.
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The Welcome Screen
Get to Know Photoshop Elements 11
In this chapter, we’ll look at the various workspaces in Photoshop Elements – and
then we’ll dig deeper, looking at the dozens of cool tools Adobe has added to
make the program even more fun to use.

The Welcome Screen
The Welcome Screen is the panel that greets you when you launch the program.
(There’s a similar Welcome Screen for Premiere Elements.)
There are two photo editing workspaces which can be launched from the
Photoshop Elements Welcome Screen.
• The Photo Editor button launches the main Editor workspace, where
you’ll likely do most of your photo and image file editing.
• The Organizer button launches the Elements Organizer, a media file
management program that also includes tools for cleaning up photos,
creating photo projects and sharing your photo and video projects. We
discuss the Elements Organizer and its many powerful tools in Section 3.
You can, by the way, re-open this Welcome Screen at any time by selecting the
option under the Photoshop Elements Help menu.

Bypass the Welcome Screen
If you’d prefer not to be
greeted by the Welcome
Screen, you’ll find options for
launching directly into the
Editor workspace by clicking
on the gear icon at the top
right of the screen.
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The Editor workspace
The Editor workspace in Photoshop Elements 11 is actually several photo editing
workspaces, each with its own set of tools and features. It’s three main workspaces can be
accessed by clicking on the tabs at the top center of the interface.
• In the Quick Edit workspace, you’ll find a simplified set of tools for cleaning up or
enhancing your photos. We’ll show you how to use the tools in this workspace in
Chapter 3.
• In the Guided Edit workspace, the programs walks you, step by step, through the
editing process. The Guided Edit tools can do some pretty advanced things too!
Not only will the Guided Edits walk you through simple clean-up of your photo,
but it will also take you through some pretty high-level photo tricks, like creating
a photo that seems to be standing on a reflective surface, an image with a TiltShift effect applied and a photo in which someone seems to be popping right of
the frame! We’ll show you how these cool edits work in Chapter 4.
• The Full Edit workspace (illustrated above) includes a comprehensive photo
editing and graphics creation Toolbox. This is likely where you’ll do most of your
“serious” editing. It most closely resembles the workspace in the professional
version of Photoshop. Needless to say, it’s the workspace most of this book is
about.
Additionally, the Editor workspace shares a number of tools for creating fun photo
pieces with the Elements Organizer under the Create tab. We discuss these tools and
how to use them in Chapter 34, Create Fun Pieces.
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The Expert Edit Workspace
The Expert Edit workspace is modeled after the interface in the
professional version of Photoshop.
As illustrated at the top of the facing page, in Photoshop Elements, you can
have the option of displaying your open photo and image files as a single
tabbed set, each photo filling the Editor workspace panel and each open file
represented by a a tab at the top of the workspace – or displaying your open
photos as floating windows, a stack of open files that you can drag into any
position around your workspace as you edit them.
To float your windows, you must have Enable Floating Documents checked
on the General screen under Edit/Preferences, as in the illustration above.
The option to display your files in either mode – as well as a number of
optional tabbed arrangements – is found under the Layout menu button.
The Layout menu button appears along the bottom of the
interface, as seen in the illustration.
As many veteran Photoshop users know, there are advantages
to displaying your photos as floating windows rather than a tabbed set.
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For instance, when your files are displayed as floating windows, you can copy images,
portions of images and even entire layers from one image file to another simply by
dragging these elements from one open file to another.
As in the illustration above, there are two ways to switch between displaying your
photos as a docked, tabbed set and displaying them as floating windows:
• Set the Arrange menu to Float All Windows. When click on the Arrange button
and select Float All Windows, all of your photo files will display as floating windows.
• Undock a photo from the tabbed set by dragging on its tab. When you pull the
photo file by its tab from the others in a tabbed set, it becomes a floating window.
Floating windows, by the way, always float over tabbed photo files. This means that, in
order to get to the photos in your tabbed, docked set, you may have to either minimize
any floating windows or drag them out of the way.
To dock or re-dock a photo into a tabbed set, simply drag the floating window by its
docking header (the top of the window) to the top of the Editor workspace. When the
photo file becomes semi-transparent (as illustrated above) release your mouse button
and the photo will dock to the set.
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When you first open the program’s
Expert edit workspace, this Panel Bin
will be in Basic Workspace mode.
In Basic Workspace mode, you can
view the Layers, Effects, Graphics or
Favorites panels in this bin by clicking
on the buttons in the lower right of the
program’s interface.

Guides and Rulers

If you click on the arrow to the right
of the More button, you will find
the option to set the Panel Bin to Custom Workspace, which opens the
Layers, Effects and Graphics panels (and their respective sub-panels) in
the Panel Bin in a tabbed set, as illustrated below

Optionally, Photoshop Elements will display Guides over your image files.
These horizontal and vertical lines don’t show up on your final piece, of
course. But they can be a great help for placing elements and text and
ensuring that they are properly lined up.

You can click and drag on any tab in the Panel Bin to make its panel
a separate, floating panel. (It’s common for experienced Photoshop
Elements users to make the Layers panel a floating panel so that it is
always available.)

The program can also display Rulers which, like Guides, can be very
helpful in measuring and placing your imagery.

Clicking directly on the More button will open an additional bundle of
tabbed panels, including Info, Navigation, History, etc. These panels can
likewise be accessed by clicking on the appropriate tab or, by dragging on
the tab, can be made a separate, floating panel.

To display Rulers, select the option from the View drop-down on the
Photoshop Elements Menu Bar.
To create a new Guide, click and drag onto your photo from one of the
Rulers running along the tops and sides of your image files. (Drag from
the Ruler along the top of your photo to create a horizontal guide or from
the Ruler along the left of your photo to create a vertical guide.)
To toggle between displaying and hiding the guides on your image files,
press Ctrl+; on a PC or +; on a Mac or select the option from the View menu.

The Toolbox
Along the left side of this workspace is the program’s Toolbox (as
illustrated on the left). The tools in this panel serve a number of functions,
from selecting areas in your image file to creating graphics and text to
patching and cloning areas of your images. As each tool is selected, that
tool’s individual settings are displayed in the Tool Options Bin that runs
along the bottom of the editing workspace.
We’ll spend considerable time getting to know the tools in the Toolbox
and how to use their settings and options in Chapter 5, Get to Know the
Photoshop Elements Toolbox.

The Panel Bin
To the right of the editing workspace is a column known as the Panel Bin,
which includes a number of tools and panels that vary, depending on
whether you’re in Quick Edit, Guided Edit or Expert mode.
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The Photo Bin
Running along the bottom of the Editor workspace and sharing space with
the Tool Options Bin is a small but powerful panel known as the Photo Bin.
When the Photo Bin button is selected in the lower left of the program’s
interface, all photos and image files you have open in your Editor workspace
will appear as thumbnails in this bin.
To open a file in your Photo Bin in the Editor workspace, double-click on its
thumbnail in the Photo Bin.
Although this is the default and most common way to use the Photo Bin, it is
certainly not its only function. The Photo Bin also interfaces with a number
of other workspaces.
To access and change the Photo Bin’s display options, click on the bin’s
drop-down menu, which reads Show Open Files by default, as in the
illustration above.
Show Open Files. Displays, as thumbnails, all of the image files you
currently have open in your Editor workspace.
Show Files Selected in the Organizer. If you have both Photoshop
Elements and the Elements Organizer open and you have files selected
in the Organizer’s Media Browser, selecting this option displays those
files in the Photo Bin. These photos or image files can then be launched
in the Editor workspace by double-clicking on them.
Albums. If you have Albums created for your image files in the Organizer,
these Albums will also be listed on this drop-down menu (as in the
illustration above), and their images can be accessed as a group simply
by clicking on the Album’s name. To learn more about creating Albums,
see page 420 of Chapter 33, Manage Your Files with the Organizer.
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What’s new in Photoshop Elements 11?
Adobe has really given Photoshop Elements, as well as Premiere Elements
and the Elements Organizer, a major overhaul in version 11.
To improve readability, the program now uses a bigger, brighter interface
with its tabs and buttons labeled with big, clean text.
To reduce clutter, more tools are hidden under buttons or stored in tabbed
interfaces – easy to access but out of the way.
And the program itself has been tightened up, improving performance and
stability, even when working with large photo files.
Additionally, the folks in San Jose have ladled on the new features,
particularly in the Quick and Guided Editing workspaces, where you’ll find
lots of new tools for cleaning up your pictures and creating photo effects.
Among the highlights are:

An improved Quick Edit workspace
Open your photo in the new Quick Edit workspace and you’ll find tools
for adjusting its exposure levels, correcting its color, shifting its color
temperature and sharpening the picture. In addition, this space now
includes tools for fixing red eyes, whitening teeth and removing blemishes.
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Its lighting and color adjustment tools use an
intuitive new Quick Fix Preview tool, which
allows you to test drive any changes to your
photo simply by hovering your mouse over
the variations on its tic tac toe-style panel.
We discuss it in depth in Chapter 3.

New Guided Edits
There are also many improvements to the
Guided Edits workspace, with its wizard-like
tools that take you step-by-step through
process of correcting or improving your
photos or creating special effects.
Nearly every tool in the Photoshop Elements
Toolbox shows up somewhere in its Touchup
Guided Edits.
Additionally, Adobe has added some cool, new
effects to its Guided Photos Effects. Among
these are step-by-step wizards for creating
a High Key and Low Key effect, for turning
your photo into a Line Drawing, for adding
a Vignette Effect or for creating a Tilt-Shift
effect that exaggerates depth-of-field so that a
scenic photo can appear to be made up of tiny
miniatures.
We’ll show you some of its highlights in
Chapter 4.

The Actions Panel
And, as if a larger library of Guided Edits
weren’t enough, Adobe has also included an
Actions panel, a very cool feature borrowed
from the professional version of Photoshop.
Actions are pre-recorded effects or other tasks
that can be applied to your photos simply by
“playing” them.
Among the included library are Actions
that add borders to your photos, resize or
crop them, Actions that add a faded ink or
sepia tone to your image and Actions that
automatically make your photo look like a
Polaroid-style snapshot!
We’ll show you how it works in Chapter 4.
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The Tool Options Bin
The old Options Bar has been replaced by a bigger, more feature-rich Tool
Options Bin. Customization options for your tools are easier to access, and
many include new settings and presets.
This Tool Options Bin even includes support for tablets, so that many of
your Photoshop Elements tools can more effectively interface with devices
like the Wacom Bamboo and other drawing tablets.

New Filters
Some very nice new filters have been added under the Sketch
category.
The Pen & Ink filter makes your photo look as if it were drawn and
painted with ink.
The Comic filter does an amazing job of making your photos look
as if they are illustrations in a comic book.
And the Graphic Novel filter gives your photos the look of a
highly stylized ink drawing.
We talk more about photo effects and filters in Chapter 11.

Improved Camera RAW support
If you’re a “serious” photographer, you’ll
likely also appreciate the improvements
to the Camera RAW interface. In fact, it’s
surprising to see such a powerful Camera
RAW interface on a consumer product.
But, particularly in the last couple of
years, Adobe has put a tremendous
amount of effort into making Photoshop
Elements more up to the task of working
with this advanced digital photo format.
We’ll discuss Camera RAW in more detail
in Chapter 13.
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Advanced Re�ne Edge Options
The Re�ne Edge tool has also been given a major upgrade
in version 11. Borrowing some advanced features for refining
selections from the professional version of Photoshop, the new
Re�ne Edge tool makes selecting around fine details, like fur
and hair, not only easier but practically automatic!
We show you how to use this amazing new tool in Chapter 6.

Organizer improvements
Adobe has put at least as much time and effort into improving
the Elements Organizer as it has Premiere Elements and
Photoshop Elements.
Not only does the program perform more efficiently than ever
before, but Adobe has added or
expanded its ability to search and
manage your media files by the
location the video or photos were
shot, the people in the picture, the
event they recorded and even by
their similarity to other video and
photo files.
It’s so big we’ve dedicated the
entirety of Section 3 of the book
to it!

Need some Basic Training?
Need more help learning the basics of Photoshop Elements?
Check out my free tutorial series Basic Training for Photoshop Elements at Muvipix.com.
This simple, eight-part series will teach you the basics of photo resolution and show you
how to adjust lighting and correct color in your photos, work with layers, add effects, scan
your pictures and even share your photos and videos online. And, yes, it’s absolutely free!
To see the series, just go to http://Muvipix.com and type “Basic Training for Photoshop
Elements” in the product search box. (We also offer Basic Training tutorials for other
products, include Premiere Elements.)
And while you’re there, why not drop by the Community forum and say hi! We’d love to
have you become a part of our growing city. Hope to see you there!
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